
 Bulletin Maker Help

Table of Contents:
Bulletin Maker Overview
Creating a Bulletin
Commands
Keyboard
How To...
Hints & Tips

Note to beginners:
We recommend that you use the Help on Help command on the Help menu 
to learn how to use this help file.
In the mean time, point to one of the underlined topics with the mouse and 
click the left mouse button or use the Tab key to highlight an underlined 
topic and press enter.



 Bulletin Maker Overview

Bulletin Maker provides the easiest way yet to produce a church bulletin.    
You control the layout and content of the bulletin while Bulletin Maker takes 
care of the hard part.

The common 8 ½" x 11" and 8 ½" x 14" size bulletins can be created using 
Bulletin Maker.    You can specify whether you want the bulletin text to start 
on the front or inside page depending on whether you use bulletin paper 
with preprinted covers.

While typing in the bulletin text, you work in a Text Editor which can show 
the text in a larger, easier to read, size than will be printed on the paper.

Your bulletin information may be saved so that you can retrieve it later to 
review, make changes, and print.    Since the layout of your church's bulletin 
will probably not change too much from week to week, you can retrieve a 
previous bulletin, make changes for the new week, and save it as a new 
bulletin.

Most general features from word processor and desk top publishing 
programs have been included in Bulletin Maker so you will only need this 
one program for all of your bulletin production needs.

Bulletin Maker also includes some features not found in other programs like 
the Left / Right justify command which aligns a line of text with both the left 
and right margins by splitting it in the middle (great for Hymns).    Also, your 
bulletin is printed "side ways" with the bulletin text printed at the proper 
place for folding (pages 1 & 4 on sheet 1 and pages 2 & 3 on sheet 2).

This help file is designed to be used both as a way to learn Bulletin Maker 
and as a reference to Bulletin Maker commands and features.    When first 
learning Bulletin Maker, you may want to start with the Creating a Bulletin 
section then read the Hints & Tips section.

Bulletin Maker was developed by Todd R. Shingleton for T.R.Software.    Our 
most current address and phone number can be displayed by selecting the 
About Bulletin Maker choice on the Help menu.    Feel free to contact us at 
any time with questions or comments about the Bulletin Maker program and 
your progress with it.



Creating a Bulletin

In time, you'll probably develop a pattern of using Bulletin Maker that works 
best for you.    To begin with though, you may wish to follow the steps listed 
below.

1. Select the File New command.

2. Click on the Typewriter or select the Edit Text command.

3. Type the bulletin text into the Text Editor window and click the done 
button.

4. Select the Edit Select All command.

5. Click on Fonts & Styles or select the Text Fonts & Styles command and 
choose a font and style that will be used for most of the bulletin text.

6. Selectively change the font, style, indents, and alignment of bulletin 
text.    See Selecting Paragraph(s), Text Indents, and Text Alignment.

7. Select the File Print command to print the bulletin.

8. Make changes and reprint the bulletin as needed.

9. Select the File Save command to save the bulletin.



Commands

Bulletin Maker commands are available on the drop down menus listed 
below.    Note that mouse users may also select some commands by clicking 
on a picture such as the    typewriter.

File Menu

Edit Menu

Text Menu

Help Menu



File Menu

Bulletin Maker's File menu has commands to open, print, and save bulletins.

Options:

New
Open
Save
Save As
Default Font
Page Layout
Print
Printer Setup
Exit



File New Command

The File New Command starts a new bulletin file.    All existing bulletin text is
discarded and a blank paragraph is created with the Default Font.

Before discarding existing bulletin text, Bulletin Maker will ask if you would 
like to save your changes, if you answer yes, Bulletin Maker will 
automatically do the File Save command.



File Open Command

The File Open Command allows you to retrieve a bulletin that was saved 
with the File Save or File Save As Commands.

If you already have bulletin text in Bulletin Maker when you select this 
command, it will ask if you would like to save your changes, if you answer 
yes, Bulletin Maker will automatically do the File Save command.



File Save Command

The File Save Command allows you to save a bulletin so it can be retrieved 
later with the File Open Command.



File Save As Command

The File Save As Command allows you to save a new bulletin or to save an 
existing bulletin under a new name.

Bulletins saved with this command can be retrieved later with the File Open 
Command.



File Default Font Command

The File Default Font Command sets the Default Font for Bulletin Maker.



File Page Layout Command

The File Page Layout Command allows you to change page margins and 
specify the Text Start page.



File Print Command

The File Print Command allows you to print the bulletin on your Default 
Printer.



File Printer Setup Command

The File Printer Setup Command allows you to change the setup of your 
Default Printer.

With this command, you can select the bulletin size.    Bulletin Maker can use
either 8 ½" x 11" or 8 ½" x 14" size paper.



File Exit Command

The File Exit Command allows you to stop working in Bulletin Maker.

If you have bulletin text in Bulletin Maker when you select this command, it 
will ask if you would like to save your changes, if you answer yes, Bulletin 
Maker will automatically do the File Save command.



Edit Menu

Bulletin Maker's Edit menu has commands to let you edit, copy, and move 
text.

Options:

Text
Edit Done
Edit Cancel
Copy
Cut
Paste
Insert
Delete
Select All



 Edit Text Command

The Edit Text Command can be selected from the Edit menu or by clicking 
the typewriter picture.

This command starts the Text Editor and allows you to add or change text in 
the currently selected paragraph(s).



Edit Done Command

The Edit Done Command is active only when you are using the Text Editor.

This command adds the text from the Text Editor to the bulletin and displays
the bulletin in the Bulletin Maker window.



Edit Cancel Command

The Edit Cancel Command is active only when you are using the Text Editor.

This command discards any changes that you made in the Text Editor and 
displays the bulletin in the Bulletin Maker window.



Edit Copy Command

The Edit Copy Command copies bulletin text from the currently selected 
paragraphs(s) to the Clipboard.    You can later paste this text back into the 
bulletin using the Edit Paste Command.

If you are currently working in the Text Editor, this command copies selected
text from the Text Editor to the Clipboard.    This text can later be pasted 
either back into the Text Editor or into the bulletin.



Edit Cut Command

The Edit Cut Command cuts the currently selected paragraph(s) out of the 
bulletin and places them in the Clipboard.    You can later paste this text back
into the bulletin using the Edit Paste Command.

If you are currently working in the Text Editor, this command cuts selected 
text from the Text Editor to the Clipboard.    This text can later be pasted 
either back into the Text Editor or into the bulletin.



Edit Paste Command

The Edit Paste Command pastes text from the Clipboard into the bulletin or 
the Text Editor.    You can only use this command if there is text on the 
Clipboard that was placed there by either the Edit Copy or Edit Cut 
Commands.



Edit Insert Command

The Edit Insert Command allows you to insert a new paragraph into the 
bulletin.    The new paragraph is inserted immediately above the currently 
selected paragraph(s) and will use the same font, alignment, and indents as 
the first selected paragraph.



Edit Delete Command

The Edit Delete Command allows you to delete the currently selected 
paragraph(s).



Edit Select All Command

The Edit Select All Command may be used to select all paragraphs in the 
bulletin.    This feature provides a way to change the fonts, alignment, and 
indents for all paragraphs in the bulletin.



Text Menu
Bulletin Maker's Text menu has commands to change fonts, align text, set 
paragraph indents, and force page endings.

Options:

Fonts & Styles
Left Justified
Right Justified
Justified
Centered
Left / Right
Indents
Page End



 Text Fonts & Styles Command

The Text Fonts & Styles Command allows you to change the font and style 
for the currently selected paragraph(s).

When you use this command, a new window appears that allows you to 
select from a list of fonts that your printer uses.    You may also set the size 
of the font in points and set styles such as Bold, Italic, and Bold Italic.



Text Alignment Commands

The Text Alignment Commands allow you to specify the alignment of text for
the currently selected paragraph(s).

These commands may be selected from the Text menu or by clicking on one 
of the alignment pictures shown below.

    Left Justified.    Text is aligned with the left margin only.

    Right Justified.    Text is aligned with the right margin only.

    Justified.    Text is spread out to align with both the left and right 
margins.

    Centered.    Text is centered between the left and right margins.



Text Left / Right Command

The Text Left / Right Command allows you to split the text of a single line 
paragraph so that it is aligned with both the left and right margins.

You tell Bulletin Maker where to split the text by inserting a tab in the line 
using the Text Editor.



Text Indents Command

The Text Indents Command allows you to indent the text in the currently 
selected paragraph(s) a specified number of inches from the left and right 
margins.

When you select this command, a window is displayed for you to enter the 
amount of indent from the left margin, the left margin for the first line in the 
paragraph, and the right margin.    To create a hanging indent, specify a 
positive amount for the left indent and a negative amount for the first line 
indent.

You must enter the indent amounts in inches.    For example, to indent text 
½" from the left margin, enter .5 for the left indent.



Text Page End Command

The Text Page End Command allows you to force the bulletin to start a new 
page after printing the currently selected paragraph(s).    If you have 
previously set a forced page end at this paragraph, this command will 
remove it.

When Bulletin Maker determines that there is more text than will print on a 
page, it will automatically insert a page end into the bulletin.    This page end
shows on the screen as a solid line.

When you force an end of page using this command, the page end shows on
the screen as a dotted line.



Help Menu

Bulletin Maker's Help menu provides commands to get help about Bulletin 
Maker and to find out how to contact the T.R.Software.

Options:

Contents
Help on Help
About Bulletin Maker



Help Contents Command

The Help Contents Command opens a help window and displays the Bulletin 
Maker help table of contents.



Help on Help Command

The Help on Help Command opens a help window and provides instructions 
on how to use help.



Help About Bulletin Maker Command

The Help About Bulletin Maker Command displays a window which shows 
how to contact T.R.Software.

Please feel free to contact us with questions and comments regarding 
Bulletin Maker and your progress with it.



Keyboard

Bulletin Maker functions and commands may be accessed by using a mouse 
or the keyboard.    Even if you use a mouse, you will probably end up using a 
combination of key strokes and mouse actions.

Keys active in the Bulletin Maker window:

Alt Provides access to the Bulletin Maker menus.
Home Takes you to the top of the bulletin.
End Takes you to the end of the bulletin.
Page Up Displays the previous screen page of the bulletin.
Page DownDisplays the next screen page of the bulletin.
Up Arrow Selects the previous paragraph.
Down Arrow Selects the next paragraph.
Ctrl+Ins Copies the currently selected paragraphs(s) text onto the 
Clipboard.
Shift+Del Cuts the currently selected paragraph(s) text onto the Clipboard.
Shift+Ins Pastes text from the Clipboard into the bulletin.

Note that holding down the shift key while using the up and down arrow 
keys will allow you to select multiple paragraphs.

See Also

Editor Keys



Text Editor Keys

The following keyboard commands can be used in the Text Editor.

Ctrl+Ins Copy the selected text onto the Clipboard.
Shift+Del Cut the selected text onto the Clipboard.
Del Delete the selected text.
Shift+Ins Paste the Clipboard text into the Text Editor.
Alt+Backspace Undo the last editing action on the current line.
Down Arrow Move down one line.
Up Arrow Move up one line.
Left Arrow Move one character to the left.
Right Arrow Move one character to the right.
Home Move to the beginning of the line.
End Move to the end of the line.
Shift+Down Arrow Move down one line and select the text in the 
previous line.
Shift+Left Arrow Select one character to the left.
Shift+Right Arrow Select one character to the right. 
Shift+Up Arrow Move up one line and select the text in both lines.
Tab Move to the next tab stop to the right.
Page Up Move to the previous screen page.
Page Down Move the next screen page.
Ctrl+Home Move to beginning of the text.
Ctrl+End Move to the end of the text.



How To...

Contact T.R.Software
Create Your First Bulletin
Change your bulletin from week to week
Copy bulletin text
Move bulletin text
Use Left / Right Justify
Use Indents
Force an End of Page



Contact T.R.Software

T.R.Software offers free technical support to Bulletin Maker Users.
Our current address and phone number can be found using the Help About 
command.



Creating Your First Bulletin

Possibly the most involved use of Bulletin Maker is when you create your 
first bulletin.    Follow the step by step instructions in the section Creating a 
Bulletin.    If you have problems following these instructions, contact 
T.R.Software for assistance.



Changing Your Bulletin From Week to Week

Bulletin Maker makes it easy to change your bulletin from week to week by 
letting you change just the information that is different each week.    This 
means that you do not have to retype your bulletin each week and will save 
time.

1. Use the File Open command to open the bulletin from the prior week.
2. Use the File Save As command to save the bulletin using a new name.
3. Use the Text Editor to change just that information which is different for

the new week.
4. Use the File Print command to print the new bulletin.
5. If necessary, make additional changes and print again until the new 

bulletin looks just the way you want it.
6. Use the File Save command to save your changes.



Copying Bulletin Text

Bulletin Maker makes it easy to copy bulletin text from one place in the 
bulletin to another.    To use this feature, select the paragraph(s) containing 
the text that you wish to copy and select the Edit Copy command.

The Edit Copy command places the text into the Windows Clipboard.

To place the copied text into the bulletin, select the paragraph before which 
the text will be inserted and select the Edit Paste command.



Moving Bulletin Text

Bulletin Maker makes it easy to move bulletin text from one place in the 
bulletin to another.    To use this feature, select the paragraph(s) containing 
the text that you wish to copy and select the Edit Cut command.

The Edit Cut command removes the text from the bulletin and places it into 
the Windows Clipboard.

To place the cut text into the bulletin, select the paragraph before which the 
text will be inserted and select the Edit Paste command.



Using Left / Right Justify

Bulletin Maker contains a feature on the Text Menu called Left / Right.

This feature is used to split a line of text and align the first half of the line 
with the left margin and the other half of the line with the right margin.    
This type of alignment works well for Hymns where the description of the 
Hymn in aligned with the left margin and the page number is aligned with 
the right.

The secret to using Left / Right is to place a Tab character in the text at the 
place you want the line split.

Example:

Using the Text Editor, type in the following line but press the Tab key instead 
of typing in {Tab}.

Hymn of Praise{Tab}No. 109

When you are back in the main Bulletin Maker screen, select this paragraph 
and use the Text Left / Right command, the line will be aligned with both the 
left and right margins.



Using Indents

Bulletin Maker lets you specify indents for selected paragraph(s).    These 
indents provide a way to temporarily change the margins for certain 
paragraphs.    Also, you may use this feature to create a hanging indent.    A 
hanging indent is when the first line of a paragraph hangs out over the rest 
of the paragraph.

Example of indented paragraph:

This text has been indented 1" from the 
left margin and 2" from the right margin.  
The first line indent is set to zero so that 
it has the same indent as the rest of the 
paragraph.

Example of a Hanging indent:

This text has been indented 1.5" from the
left margin and 2" from the right 
margin.    The first line indent has 
been set to -1.5" so that it hangs 
out over the rest of the paragraph.



Force an End of Page

Sometimes it may be necessary to force text to begin on a different page 
than Bulletin Maker places it.

To force an End of Page, select the paragraph that will be the last paragraph 
on the page and use the Text Page End command.    Bulletin maker shows a 
dotted line at the end of the paragraph to show that the End of Page was 
forced.

To remove a forced end of page marker, select the paragraph where the 
dotted line is displayed and use the Text Page End command again, this 
time, Bulletin Maker removes the forced End of Page marker.



Hints & Tips

Bulletin Maker's main strengths lie in it's ability to both improve the 
readability of your bulletins while saving you valuable time for other 
activities.

You can help improve the readibility of your bulletin by following the simple 
guidelines listed below:

Select a font and size that is large enough to be easy to read but 
still leaves room for the bulletin's message.    Times New Roman 
with a point size of 11 strikes a nice balance between readability 
and room for content.

Try not to mix different fonts and styles too frequently in the 
bulletin.    It is better to use only one font style and size for most 
of the bulletin text and use either a larger size or bold style for 
section headings.    Keep the bulletin simple and focus on getting 
your message across in the most understandable way.

Include as much blank space in the bulletin as possible.

To help save you time, follow the instructions in the section Changing Your 
Bulletin From Week to Week.    Learn to retype only the information that 
changes from week to week instead of retyping the entire bulletin.



 Text Editor

The Text Editor is accessed by clicking on the typewriter picture or selecting 
the Edit Text command.

Use the Text Editor to edit text in the currently selected paragraph(s).

Text is displayed in the Text Editor using the Default Font.    You may set the 
Default Font using the File Default Font command.    If you set the Default 
Font to a larger size, the text will be easier to read.

Since the text is displayed in a different font and margin setting than is used
for the bulletin, the text will not be formatted the same as what will print on 
paper.    Just use the Text Editor to enter the text and make formatting 
changes in the Bulletin Maker window.

You can create multiple paragraphs in the Text Editor by pressing the Enter 
(or Return) key at the end of each paragraph.    Do not press the Enter key 
after each line or Bulletin Maker will treat each line as a separate paragraph.

When you are done entering text, click the Done button or select the Edit 
Done Command.    If you wish to discard the changes you've made in the 
Text Editor, click the Cancel button or select the Edit Cancel Command.

You may select text in the Text Editor by using the Text Editor Keys.    
Selected text may be copied to the Clipboard by selecting the Edit Copy or 
Edit Cut commands.    Text placed in the Clipboard may be pasted to another 
place in the Text Editor by using the Edit Paste command.



Font
Fonts are sometimes called type faces.    They define how text will appear on the screen and
the printer.    Fonts will either be fixed spaced, such as Courier, or proportionally spaced, 
such as the font used in this help file.    In a fixed spaced font, each character takes up the 
same amount of space.    With a proportionally spaced font, character widths will vary.    For 
example, a W will take up more space than an I or a k.

You specify the size of the text in a measurement called points which is approximately 1/72 
of an inch when printed.



Indents
Indents provide a way for you to change the margins for only one or a few paragraphs.    You
specify an amount, in inches, for the left edge of the text, the left edge for the first line in 
the paragraph, and the right edge of the text.



Drop Down Menus
Drop Down Menus are listed at the top of the window and will "drop down" when you click 
them with a mouse or press the Alt key followed by the underlined letter.    When the menu 
is "dropped down", it will display a number of commands that you can select by clicking 
them with a mouse or pressing the underlined letter.



Alignment
Alignment refers to how text is "aligned" with either the left or right margins.    Text may be 
aligned with the left margin, right margin, centered, and justified so that it aligns with both 
margins.



Selecting Paragraph(s)

Most of the Bulletin Maker commands operate on selected paragraphs.    You 
select a single paragraph by pointing to it with the mouse and clicking or 
using the up and down arrow keys.

A dotted line is displayed around the selected paragraph.

You may also select more than one paragraph by holding the left mouse 
button down on a paragraph and moving the mouse toward you.    If you are 
using the keyboard, you may select more than one paragraph by holding 
down the shift key while using the up and down arrow keys.



Style
Text Styles define whether the text will be regular, like this help text, bold, italic, or bold 
italic.



Default Font
The Default Font is the font used by Bulletin Maker when you are in the Text Editor.    Also, all
text that you enter into a new bulletin will automatically be formatted in the Default Font.



Default Printer
Your Default Printer is the printer that your bulletin will print on when you select the File 
Print command.    You may change the Default Printer by selecting the File Printer Setup 
command.



Points
The height of the text characters in a font are measured in points which are approximately 
1/72 of an inch when printed.


